
NEWSLETTER #101 - April 2021

I thought it was time for a new photo! After 100 newsletters, 
it’s time to acknowledge the savage ravages of time.  But energy levels remain intact!  A new page has been turned in our history – 
it’s time to make a new mark (well, Liam, in this case…).  Yup, the jokes remain (sorry).  No refunds – but then you didn’t pay for this 
newsletter, you cheapskate!

Indeed, it’s a M A S S I V E to start our next century of newsletters.  The Power BI updates return in anger (over 50 new updates!), and 
we have news items to divulge including conditional formatting improvements in Excel, the ability to ‘Show Changes’, the propagation 
of Power Fx and an ability to convert Word documents to PowerPoint presentation.  Aside from new photos, it’s even time to start a 
new series on charts and dashboards to add to the plethora of articles.

All of the other regulars are here too: we have another Beat the Boredom Challenge, Visual Basics, Power Pivot 
Principles, Power Query Pointers, and we even find a FLOOR in on this month’s A to Z of Excel Function(s).

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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Liam Bastick, Managing Director, SumProduct

Conditional Formatting Improvements in Excel

Conditional formatting has just got better in Excel for Windows.  If you're a 
Microsoft 365 subscriber, the dialog boxes are now resizeable, so that you 
may view more rules at one time.  Furthermore, it’s also easier to see the 

formula and range that the rules apply to.  This includes the Conditional 
Formatting Rules Manager and the New / Edit Rule dialogs.

That’s not all.  If you're a Microsoft 365 subscriber, in Excel for Windows 
(and coming soon to Excel for Mac), there’s a new button so you can finally 
duplicate a selected conditional formatting rule rather than have to keep 
writing the flaming thing out.

Simply select the rule, and click ‘Duplicate Rule’ to create the copy.  This 
should be really useful when you want to create a few rules that are 
similar, but with some slight modifications.   You can create one rule, then 
duplicate it and make the necessary tweaks to the new rule.  You don’t 
need to start from scratch for each one.
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Show Changes Shows its Hand

If you have grown up with Excel, you may have become mentally scarred 
over the years with Excel’s past (in)ability to share workbooks.  Recently, 
Microsoft has revamped this in line with its priorities to emphasise 
accessibility and collaboration.  As users try this feature once more, it’s 
become important to understand what others are changing.  Therefore, 
Microsoft has been working on a new feature, ‘Show Changes’, that 
will provide an overview of all changes made to the workbook, down to 
individual cells.

In a nutshell, this feature enables you to collaborate by highlighting 
what edits were made to your workbook(s) in the past 60 days.  You can 
see details about who changed what, where, and when, along with the 
previous value of the cell for quick reversion, if needed.  You can narrow 
down the list of changes by selecting any sheet, range or cell, to check all 
the changes that were made, including bulk edits.  ‘Show Changes’ tracks 
changes made across any Microsoft 365 endpoint, i.e. Windows, Mac, 
iPads / iPhones and Android phones / tablets.

To get these improvements, you must be a Microsoft 365 subscriber, and you need to install the latest updates.  For Windows, this is version 16.0.13530 
or greater. For Mac this will be version 16.47 or later.

Here is how you can view changes for the entire workbook:
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To initiate this feature, go to the Review tab, select ’Show Changes’:

It should be noted that:

	 •	 edits are shown in the Changes pane, with the most recent first
	 •	 you can see who made the changes, where, and when, as well as what the edits were
	 •	 in cards (see below), which are tracking a similar change to multiple cells, you can see all the changes made at once by selecting ‘See changes’ 	
		  for the past 60 days:

	 •	 you may filter and see changes at a more granular level by selecting the sheet, range or cell you want, right-clicking it, and then selecting ‘Show 	
	 	 Changes’

	 •	 if someone edits the workbook while the Changes pane is open, you can update the workbook with the latest changes by selecting the ‘See 	
	 	 new changes’ button (i.e. they are not displayed automatically in real time). 
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Images above from Microsoft Insider team.

Microsoft acknowledges that there are a few known limitations while 
using ‘Show Changes’.  You are supposed to be able to see changes 
for up to 60 days, but if you have a high number of edits you may see 
changes over a shorter duration. 

So what’s the catch?  You have to store the workbook stored in OneDrive 
or SharePoint to be able to track changes.  You will also need editing 
permissions to the Excel file.  Furthermore, this feature will be rolled out 
in Excel for the web, for users running “Targeted” release builds, to begin 
with.  Still, it’s a start!

Power Fx

Microsoft Power Fx has been announced as “…the newest member 
of the Microsoft Power Platform family…”.  It is the low code language 
for expressing logic across the Microsoft Power Platform.  It is the same 
language that is at the heart of the so-called Microsoft Power Apps canvas 
apps today and is inspired by Microsoft Excel.   It enables the full spectrum 
of development from “no code” to “pro code”.

Microsoft views this announcement as a statement of direction.  There 
are no adverse implications for Power BI’s existing M and DAX languages.  
Power Fx is complementary to them: M and DAX focus on reading, shaping, 
joining and summarising large amounts of data, whilst Power Fx focuses 
on reading and writing smaller sets of relational data.

In particular:

	 •	Power Fx is open source.  Microsoft has learned from the public’s adoption of languages like C# and Typescript.  With Power Fx, we’re now 	
		  bringing that same open approach to the low code world.  Microsoft will open-source Power Fx, making the language available for open 	
		  contribution by the broader community on GitHub

	 •	Power Fx is based on Microsoft Excel.  Using formulae that are already familiar to hundreds of millions of users, Power Fx allows a broad range of 	
		  people to bring skills they already know to low code solutionsz

	 •	Power Fx is built for “low code”.  Already the foundation of the Microsoft Power Apps canvas, Power Fx will soon be extended for use across 	
		  Power Platform to Microsoft Dataverse, Microsoft Power Automate, Microsoft Power Virtual Agents, and beyond.

This table shows all of Power Fx’s pure functions, the ones marked in green are identical or very close to Excel’s version:

Excel has many more functions than this and Microsoft will be adding more all the time to Power Fx. 
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Low Code

Always Live

No Code

Pro Code

Power Fx describes business logic in concise, yet powerful, formulae, in a way that would make sense to your average Excel user.

In particular, there are many attributes worth noting for Power Fx:

	 •		  Asynchronous.  All data operations in Power Fx are asynchronous.  The maker doesn’t need to specify this, nor does the maker need to 	
			   synchronize after the call is over.  Most importantly, the maker doesn’t need to be aware of this concept at all, they don’t need to know 	
			   what a promise or lambda function is, which is just as well, as I have no idea what Microsoft is talking about!

	 •		  Local and remote.  Power Fx uses the same syntax and functions for data that is local in-memory and remote in a database or service.  The 	
			   user need not think about this distinction.  Power Fx automatically delegates what it can to the server to process filters and sorts there 	
			   more efficiently

	 •		  Relational data.  Database keys are another concept the maker doesn’t need to know about.  The maker can use simple dot notation to 	
			   access the entire graph of relationships from a record

	 •		  Projection.  When writing a query, many developers will naively write “select * from …” that brings back all the columns of data.  Power 	
			   Fx performs analysis of all the columns that are used through the entire app, even across formula dependencies.  Projection is automatically 	
			   optimised and again the maker need not even know what that word means

	 •		  Retrieve only what is needed.  The LookUp function implies that only one record should be retrieved and that is all that is brought back.  If 	
			   more records are requested by using the Filter function, for which thousands of records may qualify, only a single page of data is brought 	
			   back at a time, on the order of a hundred records.  The user must gesture through a gallery or data table to see the additional data, and it 	
			   is automatically brought in for them.  The maker can reason about large sets of data without needing to think about limiting data requests 	
			   to reasonable amounts

	 •		  Runs only when it is needed.  Calculations may be deferred until required

	 •		  Excel syntax translation.  Excel is used by hundreds of millions of users.  Microsoft wants to leveraging the knowledge users already have

	 •		  Display names and localisation.  In Dataverse and SharePoint, there is a display name for fields and tables as well as a unique logical name.  	
			   The display names are often much more user friendly, as in this case, but they have another important quality: they can be localised.  If you 	
			   have a multi-lingual team, each team member can see table and field names in their own language.  In all cases, Power Fx makes sure that 	
			   the correct logical name is sent to the database automatically.

Excel has no edit mode, compile step or run state.  Youn simply open 
your spreadsheet, you edit formulae and values freely and work with 
the results.  The spreadsheet is always live while in Excel and there is 
no distinction made between editing and running.  Changes in any value 
or formula are immediate propagated throughout the spreadsheet and 
the maker can quickly check for the right answer.  Any errors that Excel 

detects are surfaced immediately and don’t interfere with the rest of the 
spreadsheet.

Power Fx strives for this same live experience.  It incorporates an 
incremental compiler to update formulas while the app is running and 
without disturbing state.  

You don’t need to read and write Power Fx to start expressing logic.  
There are lots of customisations and logic that can be expressed through 
simple switches and UI builders.  Microsoft has built these “no code” 

tools to read and write Power Fx to ensure there is plenty of headroom 
for someone to take it further, acknowledging that “no code” tools will 
never offer all the expressiveness of the full language.  

Low code makers build things that sometimes require the help of an 
expert or are taken over by a professional to maintain and enhance.  
Professionals also appreciate that low code development can be easier, 
faster and less costly than building in a professional tool.  Not every 
situation requires the full power of Visual Studio.

Professionals want to use professional tools to be the most productive.  
This is why language tooling has been introduced that unpacks a canvas 
app into constituent parts that can be edited with Visual Studio Code or 
Visual Studio:
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In Summary

Power Fx is the new language for expressing logic across the Microsoft 
Power Platform.  It's not so much a new programming language as the 
“announced new name” for the formula language for the canvas apps.  

It is intended to be a general purpose, strong-typed, declarative and 
functional programming language, sharing many of the same syntax and 
functions as Excel.

Convert Word Documents to PowerPoint Presentations

Beat the Boredom Challenge

What!?  Not Excel or Power BI!?  I have to mention this piece of news, 
because this – if it works (caveat, caveat) – will be brilliant.  With Office 
Insiders, you can now transform Word documentsd into PowerPoint 
presentations.  I cannot tell you how much of my life I have wasted on this 
transformation!

When you use the Transform command, it creates a presentation based 
on all the summarised sections of the document (yes, I am not quite sure 
what that means either…).  It also adds imagery, icons, videos, themes and 
fonts using Artificial Intelligence. 

With many of us currently “working from home” / quarantined, there are only so Zoom / Teams calls and virtual parties you can make before you reach 
your (data) limit.  Perhaps they should measure data allowance in blood pressure millimetres of mercury (mmHg).  To try and keep our readers engaged, 
we will continue to reproduce some of our popular Final Friday Fix challenges from yesteryear in this and upcoming newsletters.  One suggested solution 
may be found later in this newsletter.  Here’s this month’s…

To convert your Word document into a PowerPoint presentation: 

	 •		  open any document you want to convert into a presentation in Word for the web
	 •		  click File -> Transform -> Transform to PowerPoint presentation
	 •		  when prompted, choose a design theme for your presentation
	 •		  click ‘Open presentation’ to review the results in PowerPoint for the web
	 •		  the presentation will be created in your OneDrive root folder. 

For this newsletter’s challenge, we are again pulling inspiration from a recent consulting problem.  We were presented with data similar to the following:

Transform your document to PowerPoint presentation is available in 
Word for the web to the First Release audience, and will be rolled out to 
all web users slowly but surely.   It should also be noted that this feature is 
currently only available in English and is not available for Internet Explorer 
(isn’t that a Microsoft product?) and Safari browsers.  Presently, this 

feature only supports text content for the transformation to presentation; 
other media content support is not currently available.  However, you may 
also add your own media to the presentation after you have tranformed 
your Word document. 
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However, our client wants it presented as follows:

It’s neither a pivot nor an unpivot, but something in between…  Maybe 
Power Query is the solution to his one (hint, hint)..?  This is the challenge 
this month: can you find a solution that will allow you to automatically 
transform the first table into the second one?

Sound easy?  Try it.  One solution just might be found later in this newsletter 
– but no reading ahead!  

Charts and Dashboards – a New Series

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  We’ll start off basic, and knowing 
us, probably remain there forever more…

Charts are visual representations of data organised into a graphical format.  Data is usually represented by symbols like bars in a bar chart, lines in a line 
chart or areas in an area chart.  

For those using their eyes for the first time ever, here is an example of a column chart:

and here is one of a line chart:
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We can simply create charts using Excel.  All Excel versions offer chart creation tools.  To insert a chart, this varies slightly between versions of Excel, but 
typically, it goes something like this.  Just go to the Insert tab:

However, on the Insert tab, there are several new chart types available only in Excel 2016 / Office 365 onwards, such as Box & Whisker, Funnel, 
Histogram – Pareto, Sunburst, Treemap, Waterfall, and in Excel 2019, Filled map. 
There, a key question is: how do you know which version of Excel you are using?

	 •		  In the File tab on the Ribbon, choose Account:

	 •	 	 Then, select the ‘About Excel’ option.  The version of Excel will be displayed at the top of the pop-up window:
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We use charts to turn data into information.  For example, we are not able to determine patterns in the data just by looking at raw numbers:

However, with a chart, life is much easier:

We’ll continue next month…

Visual Basics

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  This 
month, we thought we’d look at some of the ways you can apply range modifiers to change what set of cells exactly you’re referring to.

Consider the following table:
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The first two are probably the most common ones that we tend to see in 
code.  The Offset property is a simple way of choosing cells with reference 
to a single base cell.  This can be used to start in a single row, and loop 
through code a number of times, referring to a new row with each loop.  
The loop variable that is increasing in size (e.g. in a For loop) can be set as 
the ‘r’ value in the Offset property, for example.

The second property is useful when you know where your data starts at 
the top of a column, but you don’t know where it ends.  Range(“A1”).
End(xlDown) will go to the bottom of your dataset, so you can determine 
where your last data point is.

You can actually combine these properties together as well.  To select 
the next new row at the bottom of your data, you can use Range(“A1”).
End(xlDown).Offset(1,0) to firstly go to A1, go down to the bottom of your 
data, then offset the result by one row down, to pick the next blank row.

These are really useful tools that you can use to adjust the ranges that you 
refer to, helping you run loops or work with uncertain sizes of data.

More next time.

Power Pivot Principles

We continue our series on the Excel COM add-in, Power Pivot.  This month, we consider further why disconnected tables may be useful in Power Pivot.

In last month’s newsletter, we highlighted how useful connected tables can be when creating measures.  This time, we will cover a useful application 
of disconnected tables, using them to help calculate values in different currencies.

I’ll begin with creating the following table in Excel; note that the values in column B have to be derived through this formula: 

=TEXT(A2,”0.00”)

Once this table has been created, highlight it and convert the range into a Table (CTRL + T).  The next step is to highlight the entire Table and copy 
it into Power Pivot.  I have named this Table Exchange_Rate.  We can do this by going to the ‘Power Pivot’ tab on the Ribbon and selecting the ‘Add 
to Data Model’ option, viz.
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After adding the table to the Data Model, we can create a new PivotTable through Power Pivot with [Sales] by SalesTerritory:

Create a measure called FX:

=MAX(Exchange_Rate[A$ Per Euro])

Add a slicer on the Exchange_Rate Table, on the ‘AUD Per Euro’ column.
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Note the fact there are two “tables” called Exchange_Rate – one referring to the Table itself and one to the table loaded into Power Pivot.  We have 
selected the Power Pivot one in the image (above).

This slicer does not manipulate the PivotTable, as the slicer updates the Table but not the PivotTable – this is because they are not connected!

What’s next?  Well, let’s create a new measure:

=[Sales]/[FX]

Now remove the other fields from the PivotTable’s ‘Values’ area so we just have the ‘Sum of SalesAmount’ and ‘Sales in Euros’.

Now remove the other fields from the PivotTable’s ‘Values’ area so we just have the ‘Sum of SalesAmount’ and ‘Sales in Euros’.

More Power Pivot Principles next month.

Power Query Pointers

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at 
how to customise function descriptions by using the M function meta-data.

Previously, we have created a function called FormatExpenseType which combined a text and a number field to give us our expense type:
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In the workbook, the function is shown in the query pane:

We would like to provide a potential user of this function with more 
information to help them use it.  In M language, there are a collection of 
functions under the heading ‘Documentation’.  Since this is a part of how 
M language is constructed, these functions are not easy to find.  They are 

all in the Power Query M Language specification, which can be found at 
https://msdn.microsoft.com/library/mt807488.aspx, which is a good read 
if you are having trouble sleeping.  These are the functions that we are 
interested in:

Documentation.Examples    list	

List of record objects with example usage of the function.  Only displayed as part of the function information.  Each record should contain the following 
optional text fields: Description, Code, Result

Documentation.LongDescription    text	

Full description of what the function does, displayed in the function information

Documentation.Name    text	

Text to display across the top of the function invocation dialog

Documentation.AllowedValues    list	

List of valid values for this parameter.  Providing this field will change the input from a textbox to a drop-down list.  Note: this does not prevent a user 
from manually editing the query to supply alternate values

Documentation.FieldCaption	    text	

Friendly display name to use for the parameter

Documentation.FieldDescription    text	

Description to show next to the display name

Documentation.SampleValues	    list	

List of sample values to be displayed (as faded text) inside of the text box.

We may use some of these functions in a blank query, as shown below, so that it is clear which functions are controlling the descriptions and examples. 
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When you click ‘OK’ (the function is displayed in the way we have determined), note the deliberate mistake: we have called the function a number 
instead of text (func() as number).

This shows how the descriptions and examples are definitely controlled by us – even down to calling it a numerical function when it isn’t!  We can control 
the metadata in any custom function that we create.

More next month!

The full list reads as follows:

Reporting

	 •		  DirectQuery for PBI datasets and Azure Analysis Services and 		
			   updates (Preview)
	 •		  Search bar
	 •		  Model view updates (Preview)
	 •		  New Field List and updates to new Field List (Preview)
	 •		  Small Multiple (Preview): gridlines and background colours
	 •		  Word-wrap in Small Multiples titles (Preview)
	 •		  Updates to background settings on Small Multiples (Preview)
	 •		  Color picker and updates
	 •		  Smart guides for aligning objects are now available in the Mobile 	
			   layout view
	 •		  New filter operations: “is empty” and “is not empty”
	 •		  More granular control over certificate revocation check for web 	
			   connections
	 •		  Advanced Data Selection in Azure Maps Visual

Analytics

	 •		  Anomaly detection now in the Ribbon 
	 • 		 X axis constant line for line charts

Data connectivity

	 •	 	 Snowflake: Support for custom roles
	 •	 	 Parquet files: connector available in Power BI Desktop
	 •	 	 Hive LLAP: support for Windows authentication
	 •	 	 Salesforce: API update
	 •	 	 SAP HANA and BW: new documentation
	 •	 	 Kerberos-based SSO for Denodo
	 •	 	 Certified Connectors

Service

	 •	 	 Email subscription attachment
	 •	 	 Featured content on Home updates
	 •	 	 View dataset details from workspace List view
	 •	 	 Filter apps gallery to view only endorsed apps

Mobile

	 •	 	 Easily find your organisation’s endorsed content using the Mobile 	
	 	 	 app
	 •	 	 Power BI Free license users can now navigate to workspaces in 	
	 	 	 the Mobile apps

Power BI Updates

Sorry these didn’t make last month, but our publishing deadline forced 
us to abandon these changes.  Nevertheless, welcome back Power BI 
updates!  There were the usual Previews, as well as a new colo(u)r selector, 
new filter operations, a search bar and an easier way was introduced to 
configure email subscription attachments.

But there were more.

In a second set of updates, Microsoft has also continued its work on 
the ongoing Previews of DirectQuery for Power BI datasets and Azure 
Analysis Services, Small Multiples, and the Model View User Interface 
(UI).  Also, it has been made easier to specify filters in the DAX CALCULATE 
function.  On the Power BI Service side, when you click on a dataset in the 
workspace list view, you will be taken to the new dataset details page, 
which includes information about when the report was last refreshed, as 
well as actions such as creating a new report.
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Modelling

	 •	 	 Model View UI (Preview)
	 •	 	 IF.EAGER
	 •	 	 CALCULATE filters now easier to use

Visualisations

	 •	 	 New visuals
	 •	 	 Shielded HTML Viewer by Nova Silva
	 •	 	 Zebra BI Tables (version 4.5)
	 •	 	 Zebra BI Charts (version 4.5)
	 •	 	 ValQ 2.0 released with connected and collaborative 	
	 	 	 planning features
	 •	 	 Drill Down Combo PRO by ZoomCharts
	 •	 	 SMART KPI List by Nova Silva
	 •	 	 Comparison chart
	 •	 	 Combo Bar PRO visual

Template apps

	 •	 	 Microsoft partners: installing a preconfigured template app
	 •	 	 Sales analytics AI for Microsoft Business Central
	 •	 	 Download PBIX files for installed template apps
	 •	 	 Analyse popular stocks with Power BI
	 •	 	 Facebook Ads Overview Report – by Windsor.ai

DirectQuery for PBI datasets and Azure Analysis Services and updates (Preview)

DELETING DIRECTQUERY CONNECTIONS

You can now delete DirectQuery connections to Power BI datasets and Azure Analysis Services.  To do so, go to the Data Source Settings dialog, which 
you can find in the dropdown for ‘Transform data’

You should note that this does not reverse the action of adding a local model: this action deletes the DirectQuery connection and all the tables and fields 
associated with that connection.

Developers

	 •	 	 Visual container fix
	 •	 	 EnumObjectInst with no datarole support

Embedded

	 •	 	 The new Power BI embedded analytics playground
	 •	 	 Power BI Embedded Generation 2 (Preview)
	 •	 	 Power BI embedded analytics new Contoso demo
	 •	 	 New Client API documentation

Other

	 •	 	 New icon update
	 •	 	 Advanced notice: Microsoft 365, including Power BI, ending 	 	
	 	 	 support for Internet Explorer 11 and legacy version of Microsoft 	
	 	 	 Edge
	 •	 	 Paginated reports export API is now Generally Available
	 •	 	 Windows 7 deprecation
	 •	 	 Certificate revocation check controls now available in Desktop 		
	 	 	 interface
	 •	 	 External Tools integration in Desktop Generally Available
	 •	 	 Desktop change log.

You know the drill by now.  Let’s go through each in turn.

In the ‘Data source settings’ dialog, right-
click on the DirectQuery connection 
you’d like to delete:
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CALCULATED TABLES

Microsoft has also announced that they have added support for calculated tables.

DISPLAY FOLDERS AND ‘SORT BY COLUMN’
Now, display folders and ‘Sort by column’ properties set in a remote source will be synchronised with your local Power BI Desktop model.

Search bar

This update sees an amendment to the Power BI Desktop Ribbon.  
Microsoft has stated that they have received feedback that sometimes 
it can be difficult to find the commands, files or other options you are 

looking for.  Therefore, in Power BI Desktop you can now see a Search 
bar, just like you can in other Office applications.

When you click on the Search bar, Power BI will suggest some actions for you to take based on the current state of your report, e.g.

As you type in a keyword, the search results will update to show you buttons that are related to your search.  You can also click ‘Get help’ and be 
directed to the official Microsoft documentation (let’s hope it’s not M you are querying!).

If you have a visual or field selected, special tabs show up on the Ribbon, with context specific buttons.  If you select a visual or field, those special 
Ribbon buttons will be included in your Ribbon search results as well.  For example, the following image shows when a field has been selected, so the 
‘Data type’ option shows up in the Search box:
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Just before all our foreign readers get too excited, please note that for the time being, this is only available in English (United States) presently.  Good 
look getting help with colours then… 

Model view updates (Preview)

This update sees the colours in the table card headers will match the colours in the report theme you are using.

If your theme uses a colour that is almost white, it won’t be used in 
the table headers.  This is to mitigate situations where it can be hard to 
differentiate tables in dual mode.

Further, the relationships have a new look where the direction and 
cardinality has been centralised rather than being spread out across the 
relationship line.
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This doesn’t appear to be to everyone’s taste, but it should be noted that this is a Preview.  

Microsoft has also added options to expand and collapse all the table cards in the model diagram at once.  This may be performed in several ways.  
You may right-click on a table card in the diagram or click on the more options button to get the ‘Collapse all’ and ‘Expand all’ options.

Another approach is to right-click anywhere on the grey background behind the model diagram and the following menu options with expand and 
collapse will appear:

There are also two performance improvements:

	 1.		 The table threshold for the ‘All tables’ view has been increased to 75 tables.  If your model has less than 75 tables, the ‘All tables’ view will 	
			   be shown.  If you have more than 75 tables in your model, instead of the ‘All tables’ view, you’ll see the following image:
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	 	 	 If you’d like to bypass the threshold, you can press ‘Show all tables’.  However, Microsoft “strongly recommends” you don’t do this as 	
	 	 	 it may cause Power BI to consume extreme amounts of memory, CPU cycles, and slow down significantly.  Instead, if you want to make 	
	 	 	 modifications to your diagram, it is suggested you create custom layouts and working with a smaller number of tables at a time

	 2.		 The responsiveness of relationships drawn between tables and of moving tables in the diagram around should now be faster.  

New Field List and updates to New Field List (Preview)

Small Multiples (Preview): gridlines and background colours

Back in November of last year, the new Field List was released to the 
Model view only.  This has now been propagated to all views: Model, 
Report and Data.  This change will create consistency for functionality 
and User Interfaces across views (where applicable).  To activate, find 
the Preview feature switch in the preview options: File > Options and 
settings > Options > Preview features > New Field list. 

Further, Microsoft has now tightened the padding, added the context 
menu back when all the tables are hidden, brought back the yellow 
indicator when reordering fields in the field wells, and fixed icon 
discrepancies amongst other changes.

Continuing the updates already made on the Small Multiples Preview 
feature, Microsoft has now added gridline and background colour 

controls to the grid layout Formatting card.  These provide new options 
to clearly separate the Small Multiples plot areas.
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You can find the formatting controls in the ‘Grid layout’ card in the Formatting pane:

Here, you can now set background colour and transparency, add an assortment of different gridline patterns, and style those gridlines.

Word-wrap in Small Multiples titles (Preview)

Microsoft has continued their work on the small multiples Preview 
feature.  This update sees word wrap added to small multiple titles, so 

you may ensure your longer titles aren’t truncated if they run beyond the 
width of the small multiple column.
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Keep in mind that Power BI Desktop will allocate space for the longest 
category name in all of your small multiples to ensure the plot areas 
align properly.  As a result, if some of your small multiple titles are much 

longer than others, turning on word wrap may leave extra whitespace 
under the shorter titles.  Therefore, do consider the trade-off between 
the space reserved for plot areas and titles when considering word wrap.

Updates to background settings on Small Multiples (Preview)

Color picker and updates

Smart guides for aligning objects are now available in the Mobile layout view

Furthermore, the small multiples background colour and background 
transparency formatting settings have been updated to include new 
default values.  While the previous default value for background colour 
was automatically inherited from page background and the default 

transparency was 100% (totally transparent), the new defaults will 
instead be ‘no fill’ and 0% (totally opaque), respectively.  This change will 
allow you to see immediate changes in your small multiples background 
colours without your having to change the transparency setting.

Microsoft has updated the color picker to make it easier to work with.  The colour swatches are better separated, so it is easier to find the colour you 
need.  In the ‘More colors’ screen, you can now enter an RGB value in addition to a HEX value.

Here is a side-by-side comparison of the existing and updated experience:

Smart guides are now available in the Mobile layout view, just like in the 
regular Web layout view.  In case you’ve been living under a rock for the 
past 100 years of software development, smart guides help you align 
objects, and this is no different on the Mobile report page.  Any time you 

drag or resize objects, you’ll see these smart guides.  In addition, when 
you move an object close to another one, it will snap into alignment with 
the other object.

The latest update also sees the color picker being prioritised to pop up on the right side, so that less of it overlaps with the report canvas.  This update 
also provides a bug fix for users who could not use ESC to close the color picker.  

The problem is, this change in defaults will also affect existing reports, so:

	 •		  if you have previously adjusted transparency without changing the small multiples background colour, the previous (default) colour will 	
			   have become ‘no fill’, meaning you will no longer see a background colour on your small multiples grid

	 •		  if you have previously changed the small multiples background colour without changing transparency, the previous transparency (100%) 	
			   will now become 0%, meaning you will now see your background colour applied to the small multiples grid.

Changing your colour and transparency settings away from the new defaults will avoid this behaviour.  You have been warned!

Existing New
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New filter operations: “is empty” and “is not empty”

Two new filter operations have been added for Text datatypes: is empty and is not empty.  These new operations are located in the Filter pane in 
the ‘Advanced filtering’ type: 

The operation is empty shows items when the value is an empty string (““), whereas the operation is not empty shows items when the value is not 
an empty string (“”).

It should be noted that:

	 •		  if you have text values that have only spaces (“   ”), these values are automatically converted to empty strings (“”)
	 •		  if you’re wanting to filter out or filter to null values (no value), you’ll need to use one of the is not blank or is blank operations.
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More granular control over certificate revocation check for web connections

Advanced Data Selection in Azure Maps Visual

SELECTION CONTROL

Towards the end of last year, Microsoft introduced certificate revocation 
checks for web connections in Power BI Desktop.  The feature could be 
enabled (or disabled) by checking (or unchecking) the ‘Enable certificate 
revocation check’ in the Security pane in the Options dialog in Power BI 
Desktop.

This has now been modified to give users better control by introducing a 
“basic” check.  The “basic” check will accept certificates whose revocation 
status is unknown, for example, because the certificate does not specify 
it.  This is important for some organisations that use corporate proxy 
servers.  For instance.  You may still disable the revocation check or 
enable it in comprehensive mode, which will not accept certificates with 
unknown revocation status.

The Azure Maps Visual in Power BI provides multiple visualisation types 
(such as bubbles, 3D bar chart, real-time traffic etc.) that make it easy 
to envision your business data on a map and observe how different 

parameters change across locations.  In particular, there are new selection 
features that make it even easier to explore location data in Power BI.

This is a new selection control option, available 
in the toolbar, located on top right of the Azure 
Map Visual.  You will now have no less than 
four new methods to select and interact with 
data on the map.

Presently, the original checkbox interface will still be shown in 
Power BI Desktop, although this will be modified shortly.  To use the 
more fine-grained control today without having to wait for the user 
interface change, please set the following DWORD registry value: 
DisableCertificateRevocationCheck.  You will need to set this in Power 

BI Desktop’s registry key, which is HKEY_LOCAL_MACHINE\SOFTWARE\
WOW6432Node\Microsoft\Microsoft Power BI Desktop or HKEY_LOCAL_
MACHINE\SOFTWARE\Microsoft\Microsoft Power BI Desktop depending 
on your systems configuration.  Please consult an expert if unsure!

You can set the registry value to one of the following values:

You may configure this registry setting now to take advantage of the more fine-grained control today; these options will soon be available in any case 
in Power BI Desktop.

Value Mode  Configuration

0 Basic Certificates that have an unknown revocation status will be accepted.  Equivalent 
to enabling the checkbox in Power BI Desktop)

1 Disabled Ignore all revocation checks.  Equivalent to disabling the checkbox in Power BI 
Desktop)

2 Comprehensive Require certificates to not be revoked.
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RANGE SELECTION

RADIAL SELECTION

POLYGON SELECTION

RADIAL AND BOX SELECTION

You may use this range selection method to select all data that is within a specified driving distance or driving time from a specified location.  This 
method is especially useful to visualise the catchment area of a retail store, for example.

If you click on the ‘Circle’ icon in the selection control bar, this will activate 
the radial selection mode.  Then, click at a desired point on the map canvas 
and drag the mouse to the desired radius.  A circular region centred on the 

selection point highlights all locations within this given radial.  Simply click 
again to complete the selection.  Only selected points remain active on the 
map canvas.  To cancel the selection, click anywhere on the map.

For fine grain control of what data to select, use this polygon selection.  
With the mouse-key pressed down, drag and draw any freeform shape 
to select data lying within the shape.  To close the shape, just double click 

on the map.  Without keeping the mouse-key pressed down, you can click 
anywhere on the Map to specify vertices of a polygon boundary and select 
data within the boundary.

The radial and box selection method provides the ability to make a selection on the map using a circle or rectangle drawn on the map canvas.
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The new selection control is enabled by default.  To turn on / off this selection control, edit the Azure Map Visual and go to the Format tab in the control 
panel.  Locate the section titled ‘Map Settings’, expand it and make sure the ‘Selection Control’ toggle option is set to true (slide the control to the right).

Anomaly detection now in the Ribbon

X axis constant line for line charts

Again, late last year, Anomaly detection was available in Preview.  Now, a 
new entry point has been added for the feature in the Ribbon under the 

AI section of the Data / Drill tab.  Further, Microsoft has also decreased 
the minimum number of data points required for the analysis to four [4]. 

Power BI now supports adding a x axis constant line in line charts for continuous type data.
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You can create this line by selecting ‘Add’ on the ‘X axis constant line’ from 
the Analytics icon in the Visualizations section.  The value can be a date 
time or numerical value, depending upon your data.  You may configure 

all sorts of options for your line, from its Color, Transparency percentage, 
Line style, Position, Data Label, similar to the existing y axis constant line.

This constant line is used in visuals in the Anomalies pane to indicate the date time of the anomalies in the series.

Snowflake: Support for custom roles

Custom role support has now been added to the Snowflake connector.  
Specification of a role provides query-level granularity, as the role 
becomes part of the ‘Source’ step in each of the generated M queries, 

providing more flexibility to users.  In the connection experience, a new 
option under ‘Advanced Options’ of the Snowflake connector will allow 
users to specify a text value to use as the Role name.
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Parquet files: connector available in Power BI Desktop

Hive LLAP: support for Windows authentication

Salesforce: API update

Previously the Parquet Files connector was only available in dataflows.  
With this release, the connector will now be available in Power BI Desktop 

in the Get Data experiences.  You should note that this connector is only 
available in 64-bit installations of Power BI Desktop.

The functionality for the Hive LLAP connector has now been updated to support Windows Authentication.

The Salesforce connector has also been updated to use V48 API by default, 
to ensure up-to-date compatibility with Salesforce APIs.  Salesforce 
API versions generally deprecate after three years, often resulting in 
removed objects or properties.  If the upgrade results in removed objects 

or properties causing trouble refreshing, you may manually set the API 
version through the Advanced Editor, and then update your queries to 
be compatible with V48.

SAP HANA and BW: new documentation

Microsoft has announced that they have released new connector articles 
for SAP HANA and SAP Business Warehouse documentation:

	 •		  SAP HANA
	 •		  SAP Business Warehouse Application Server
	 •		  SAP Business Warehouse Message Server.
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Kerberos-based SSO for Denodo

Email subscription attachment

Featured content on Home updates

View dataset details from workspace List view

This update provides you with an easier way to publish Power BI reports to the Service, that connect to Denodo, using DirectQuery leveraging 
Kerberos-based single sign-on, via the on-premises data gateway.

In Power BI Service, you can now create a subscription from a premium upgraded workspace or with PPU for yourself and others and include a copy 
of all pages in your reports.  This eliminates the need to subscribe separately to each section.  It is similar to generating an export of the report.  
Attachments may be generated in either PDF or PPT.

The featured content on your Home page now includes metadata as to who featured the artifact.  Additionally, endorsed content may also be 
featured in the same workflow.

You can now open the dataset details page from the ‘Workspace content list’ view.  When clicking on a dataset in the ‘Workspace content list’ view, 
the dataset details page is opened to provide meaningful information and quick actions, including:

	 •		  information about the dataset including last refresh time
	 •		  list of reports that are built on top of the dataset (just reports that you have access to will be shown here)
	 •		  usage metrics for the past 30 days, including how many users and report opens were there for the last 30 days, not including today
	 •		  quick actions: view lineage, create a report and ‘Analyze in Excel’
	 •		  create from template: if there is a template report defined for this dataset, you can quickly create a report from this template.

Please note that this feature is only available in the New workspaces.

Certified Connectors

There is a new certified connector to add to the fold, Kognitwin, which allows users to connect to Kognitwin Energy (by Kongsberg), for advanced 
digitalisation and analytics.

There are also updates to the following nine certified connectors:

	 •		  Automation Anywhere
	 •		  Data Virtuality
	 •		  e-Way CRM
	 •		  Exasol
	 •		  FactSet
	 •		  IntelligentPlant
	 •		  MariaDB
	 •		  Vena
	 •		  Zoho Creator.
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Filter apps gallery to view only endorsed apps

When getting a new app from the apps gallery you can choose to filter the gallery to view only certified and promoted apps.  These apps were set 
by their owner as trusted.
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Easily find your organisation’s endorsed content using the Mobile app

Power BI Free license users can now navigate to workspaces in the Mobile apps

Model View UI (Preview)

In Power BI Mobile, content that has been promoted or certified in the 
Power BI Service is now tagged in the app with a badge.  Report creators 
may promote their content to show that it is ready for you to use 

(promoted) or certify their content to show that it has been approved by 
their organisation (certified).

Until now, Power BI Free license users could only access workspace 
content through the ‘Shared with me’ page.  With this release, Power BI 
Free license users can view and access workspaces for which they have 
been added as viewers directly from the workspaces list.

However, there is a catch: this change is applicable only for content that 
is hosted on a Power BI Premium capacity.

Microsoft has made some changes to how relationships look in your model diagram, viz.  

The cardinalities are now shown at the end points of a relationship and the direction of the relationship is shown at the centre.  These icons have also 
been increased in size to be more legible. 
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LIMITED RELATIONSHIPS UI

ERROR ICONS TOOLTIPS

In the image of the new relationships look, you may have also noticed that an icon has been added:

When you are in live connect mode, errors on measures will display an error icon in the fields list and in the model diagram.  When you hover over the 
icon, a ToolTip will display more information about the error on that measure:

This icon indicates a limited relationship and easily allows you to identify them in your model.  In case you don’t know, limited relationships are 
relationships between different source groups. 

IF.EAGER

A new function has been introduced to DAX.  Ladies and gentlemen, 
please welcome IF.EAGER!  This function has the same behaviour as the 
existing IF function, but the performance may differ due to differences 
in how the function is evaluated by the engine.  IF.EAGER uses what is 
known as an “eager evaluation”, whereby the two branch expressions 

(second and third parameter) are evaluated regardless of the condition 
(first parameter) being true or false.  In contrast, IF uses strict evaluation, 
meaning it only executes one of the two branch expressions, depending 
upon the condition being true or false.
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Using IF.EAGER (and thus eager evaluation) has performance benefits, 
specifically when the same calculation needs to be evaluated for both 
the branch and condition expressions.  Consider the following example:

SalesEager := IF( [Total Sales] > [Last Month Sales], [Total Sales], [Last 
Month Sales]-[Total Sales] )

In the example above, the Total Sales measure is evaluated in the 
condition expression, as well as the branch expressions.  Additionally, the 
Last Month Sales measure is evaluated both in the condition expression 
as well as in the second branch expression.  This means that Power BI will 
evaluate Total Sales three times when using the IF function, because it 

is included in both branch expressions and when the expression is false, 
Last Month Sales will get evaluated twice.

However, switching to IF.EAGER would mean that the branch expressions 
get evaluated regardless so the Power BI engine will evaluate Total Sales 
and Last Month Sales only once as it can reuse the evaluations for the 
condition expression.  Note that this does not mean that you should 
always be using IF.EAGER instead of IF going forward.  Indeed, Microsoft 
recommends using IF, unless you have this specific situation or have 
other performance issues.

CALCULATE filters now easier to use

New visuals

Power BI has now added extra flexibility in specifying multiple filters when working with the CALCULATE function.  As an example, let’s say you 
needed to calculate the sales amount for products that are either red or are part of a product line for women (style indicator ‘W’).  You already have 
a measure, Sales Amount, which is defined as: 

Sales Amount := SUM(Sales[SalesAmount])

You might be tempted to try the following I “old” Power BI DAX:

SalesRedW := CALCULATE(Sales[Sales Amount], Product[Color] = "Red" || Product[Style] = "W")

Unfortunately, this would not work:

There are some new visuals for you to explore:

	 •		  Graphomate matrix
	 •		  ParaTaskCard
	 •		  SMART KPI List
	 •		  Lipstick Column Chart
	 •		  Lipstick Bar Chart

	
	 •		  Control Chart XmR
	 •		  ParaHTMLViewer
	 •		  Merged Bar Chart
	 •		  Animated Image and Bubble Chart
	 •		  Animated Bar Race Chart

	
	 •		  Dynamic Radial Bar Chart by JTA
	 •		  Text Highlighter
	 •		  Multi Card KPIs, by TME AG.

In order to make this work, you had to add an explicit table filter, like in the following example:

SalesRedW := CALCULATE(Sales[Sales Amount], FILTER( ALL( 'Product'[Color], 'Product'[Style]), 'Product'[Color]="Red" || 'Product'[Style]="W"))

However, starting with this release, the first syntax you tried works.  This is now perfectly valid DAX and will work without error messages:

SalesRedW := CALCULATE(Sales[Sales Amount], Product[Color] = "Red" || Product[Style] = "W")

This makes it easier to build calculations that require multiple filters and complex combinations of conditions, such as OR (||) and (&&).
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Shielded HTML Viewer by Nova Silva

Zebra BI Tables (version 4.5)

Context is paramount when preparing data visualisation reports (charts and 
dashboards, to you and me).  Power BI visuals that allow users to add HTML 
formatted content to their reports and dashboards are proving popular.

Whilst showing HTML formatted content can add value to your reports, it 
may also form a potential security risk.  Shielded HTML Viewer is an HTML 
Viewer for Power BI certified by Microsoft that “shields” these risks.

This Zebra BI Tables visual introduces a brand new formula editor so you 
can add custom-calculated rows directly in the visual.  It also supports 

dynamic commentary and has the ability to invert and rename groups in 
tables, amongst other new features.

The Shielded HTML Viewer (in the image above, it has been used in the 
ToolTip of a Dumbbell chart) is based on a so called “allow-list”: only 
those HTML tags and attributes mentioned in this list will be interpreted 
and formatted accordingly.  Anything else will be ignored, so that there 
is no risk of running harmful HTML codes.  Furthermore, all functionality 

is available through the standard Power BI interface, so there is no need 
to learn a new interface.

This may be downloaded from the AppSource.  All features are available 
for free to evaluate the Shielded HTML Viewer within Power BI Desktop.
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Zebra BI Charts (version 4.5)

ValQ 2.0 released with connected and collaborative planning features

The latest version of Zebra BI Charts also contains several design improvements as well as the dynamic comments, similar to Zebra BI Tables.

For example, you may now display variances with arrows pointing up / down or left / right to better distinguish between positive and negative 
variances:

ValQ 2.0 release for modern visual planning has several exciting new features.  It’s now completely free on Power BI Desktop.

New features include:

	 •		  enterprise user security: the software now allows / restricts user access to models, nodes, scenarios and planning series by user and groups
	 •		  connected planning: with the ‘Model Merge’ feature, it is now possible for users to merge and link multiple planning models
	 •		  rolling forecasts: YTD actual, budget and forecast data may be easily combined for the rest of the year
	 •		  advanced analysis: there is now an ability to perform attribution, variance and sensitivity analysis, which provides deeper insights across 	
			   various business drivers
	 •		  digital board room experience: with touch support that makes interacting with models easier on TVs and mobile devices
	 •		  collaborative planning: share scenarios and models across business users with audit and commenting capabilities
	 •		  data access options: ValQ now offers enhanced export to XLS/CSV, Write Back API, Web URL for exporting the planning scenarios, analysis, 	
			   model etc.

This feature should be useful for people with colour vision deficiencies, since the variances are distinguished by shape as well as colour.  Further, 
similar to Zebra BI Tables, the Zebra BI Charts visual also supports adding comment markers, comment ToolTips and dynamic linked comments.
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Drill Down Combo PRO by ZoomCharts

SMART KPI List by Nova Silva

Comparison chart

Combo PRO Visual by ZoomCharts lets you combine columns, lines and areas in one visual in any combination.  Among the main features for the 
Combo PRO Visual by ZoomCharts, you will find: 

	 •		  on-chart interactions: click, pan, zoom-in / out to explore multiple drill-down levels
	 •		  multiple chart types: choose between column, line and area chart for each series
	 •		  stacking and clustering: stack or cluster series, chose between series specific or cumulative (total) values
	 •		  static and dynamic thresholds: set up to three thresholds to demonstrate targets or benchmarks
	 •		  full customisation: customise x and y axes, legends, stacks, ToolTips, fill settings, outlines
	 •		  multi-touch device friendly: get equal experience on any device and many more.

Just for clarification (in case you have been living in Uranus for the past few year…), SMART refers to:

	 •		  Specific: the red-dot highlights the KPIs that need immediate attention
	 •		  Measurable: a value alone is a weak indicator of performance; a sparkline shows the trend to determine if you are moving towards your goal
	 •		  Achievable: by comparing each result with a target, you can determine if your KPI has met expectations
	 •		  Relevant: within the sparkline, you may add a range of acceptable results which help you to identify “normal” and “abnormal” results from 	
			   the past
	 •		  Time-bound: the sparkline adds the required historic context to each indicator to provide further information on each of the indicators’ 	
			   signals.

You can download this visual from the AppSource.  All features are available for free to evaluate within Power BI Desktop.

One important goal of any well-designed dashboard is to inform its readers by creating one overview of all KPI’s.  One suggestion might be to consider 
the SMART KPI List, which has been created specifically for this purpose.

If you have ever had the need to visually 
compare the development of figures, like 
“sales“ or “order volume“ with an index, 
then the Comparison Chart may help you.  
For example, you could create a chart that 
demonstrates the development of the gross 
domestic product of the top five countries 
in Europe compared to the world.  As long 
as you have access to market data you can 
compare the development of your sales with 
the sales in the market.
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When using Power BI’s default line chart you have to decide beforehand 
which products you want to visualise (via the “legend” or via measures 
for each product).  The Comparison Chart offers you the ability to select 

your top five products dynamically and visualise the index information 
on a second axis with numerous formatting options.

Again, this is located in the AppSource.

Combo Bar PRO Visual by ZoomCharts allows you to combine bars, vertical lines and vertical areas in one visual in any combination.  It has been 
developed for efficient data exploration, with single touch / click drill down and drill up functionality.

Main features include: 

	 •		  on-chart interactions: click, pan, zoom in / out to explore multiple drill-down levels
	 •		  multiple chart types: choose between bar, line and area chart for each series
	 •		  stacking and clustering: stack or cluster series, choose between series specific or cumulative (total) values
	 •		  static and dynamic thresholds: set up to three thresholds to demonstrate targets or benchmarks
	 •		  full customisation: customise x and y axes, legends, stacks, ToolTips, fill settings, outlines
	 •		  multi-touch device friendly: the intentions is to get an equal experience on any device.

Combo Bar PRO visual

Microsoft partners: installing a preconfigured template app

Last December saw Microsoft announce a new capability that enables 
template application (app) publishers to provide preconfigured template 
app installation for their customers.  When installing a template app, 
users had to configure parameters to connect the template app to their 
data.  Users often found this step confusing and were unsure about 

what information to provide, leading to many failed installations.  Now, 
as a template app publisher you can preconfigure the template app 
installation, making life easier for users and eliminating a frequently 
encountered source of frustration.
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Sales analytics AI for Microsoft Business Central

Download PBIX files for installed template apps

With the Sales Analytics for Microsoft Business Central template app, you leverage your investment in Business Central.  There are various benefits:

	 •		  here, you may drill-down to see the details of your salespeople, customers and items
	 •		  to understand customer behaviour and customer loyalty, you can use the customer retention report page.  It shows which customers per 	
			   country are new, returning, lost or recovered, and what the sales margin is compared to the previous year
	 •		  the dynamics segmentation creates price range, customer and item segmentations based on lifetime values
	 •		  the cross-analytics report page is the place to proactively explore your data and find deviations to address your actions.

Starting with this update, if you are a template app publisher, you can now allow Power BI Pro users to download a PBIX file directly from your 
template app once they’ve installed it.  All you have to do is turn on the download PBIX feature on the Control tab when you’re creating your 
template app.

It may be worth downloading and installing the free Business Central Extension.
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When PBIX download has been enabled for a template app, Power BI Pro users will be able to download the PBIX file from the report or template 
app workspace, viz.

Analyse popular stocks with Power BI

The ‘Analyze Popular Stocks with Power BI’ app (catchy name…) shows 
you multiple KPIs for imminent analysis.  You may use it to track end-
of-day quotes as well as weekly, monthly or annual trends for popular 

stocks.  Features include being able to track stock highs and lows, 
analyse moving averages, sector-wise distribution and Bollinger bands, 
plus construct performance comparisons for popular stocks over time.
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This is available on AppSource.  The app may pull refreshed, end-of-day stock data without any additional subscriptions, although getting stock data 
requires a Power BI Pro license. 

Facebook Ads Overview Report – by Windsor.ai

The first Facebook Ads template app has arrived for Power BI.  This 
application helps advertisers and marketers connect Power BI to the 
Facebook Ads Insights API.  It contains a connector, so that all you 

need to get started is access to a Facebook Ads account.  As with other 
templates, this template app offers automatic data refresh, and you can 
set a date range to get historical data.

The app has two report pages which allow you to gain insights about Campaigns and Ad Sets:
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A variety of breakdowns is available and includes breakdowns by country, age, gender, objective, device, publisher, etc.  You can also find metrics 
about cost, CPM, impressions and clicks.

To get started:

	 •		  connect your Facebook Ads Data
	 •		  take note of the API key provided
	 •		  select at least one Facebook Ads account from the dropdown

	 •	 	 install the Facebook Ads Overview Report Power BI Template App
	 •	 	 enter the API key provided

	 •	 	 on the next screen click Sign In.

Your data will then load.  This may take a while, depending upon the size of your data.
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Visual container fix

EnumObjectInst with no datarole support

The new Power BI embedded analytics playground

Power BI Embedded Generation 2 (Preview)

Power BI embedded analytics new Contoso demo

Custom visuals didn’t fully support the customise series.  However, the fix is now available for both Power BI Service and Desktop.

With the 3.6 API release, a Power BI visual can now receive updates from Power BI without the need to bind any data.  In order to use this feature, 
a visual needs to:

	 •		  use the ‘powerbi-visuals-api’ 3.6.0 version
	 •		  have these capabilities:
				    o	 ‘supportsLandingPage’ set to true
				    o	 ‘supportsEmptyDataView’ set to true.

The new Power BI Embedded Analytics playground was also announced 
in this update.  It allows developers to get hands-on coding experience 
in Microsoft’s developer sandbox, using samples or their own reports.  
Developers can discover and interact with client APIs and see instant 

results.  Additionally, you can check out the interactive feature 
showcases to get inspiration on how to apply the latest features to your 
applications.

The second generation of Power BI Embedded, referred to as Embedded 
Gen 2, became available recently for Azure subscribers to use during 
the Preview period.  Embedded Gen 2 offers enhanced performance, 
greater scale, lower entry level for paginated report and AI workloads, 

instant scaling and without downtime and improved metrics, that allow 
developers to auto-scale up and down, by scripting or using Azure Alerts 
rules.

To get started, simply:

	 •		  open the Contoso Sales Demo application
	 •		  select Salesperson
	 •		  select Enter in demo mode.

The new Power BI embedded analytics Contoso sales demo was recently 
introduced to users and Microsoft partners, allowing you to explore a data-
driven application with customised dashboard views, built upon Power 
BI embedded analytics.  Here, you may learn how a Microsoft Dataverse 
database with Row Level Security (RLS) ensures each user sees only the 

data they have access to, see APIs in action including exporting, custom 
action buttons, writeback and Service Principal-based authentication.  
Most importantly, users may now browse the open-source code behind 
the demo via GitHub and customise with their own data.
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New Client API documentation

New icon update

Advanced notice: Microsoft 365, including Power BI, ending support for Internet Explorer 11 and legacy version of Microsoft Edge

The new Client API documentation is now available.  This has been a real added-value paragraph.

Across the Power Platform Microsoft has updated their product icons to the new Fluent design system.  Their intention apparently is “…to create 
brand consistency and bring a modern, full color (sic) experience…”.

It’s time to make a change.  Any users still using Edge Legacy or Internet Explorer 11 will find products like Power BI will no longer support IE11 as of 
17 August 2021.  Microsoft Edge Legacy end of life is even earlier (9 March 2021 – which is before this newsletter comes out). 
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Paginated reports export API is now Generally Available

Windows 7 deprecation

Certificate revocation check controls now available in Desktop interface

External Tools integration in Desktop Generally Available

Desktop change log

The export API for paginated reports only is now Generally Available.  Users can take advantage of the export API in all A SKU’s, P SKU’s and Premium 
per user.

If you’re a Windows 7 user, it’s important to note that Power BI Desktop stopped supporting Windows 7 back in January.  Power BI Desktop is now 
only supported on Windows 8.1 or newer versions of Windows, and as always, for only the newest release of Power BI Desktop.

Last month, Microsoft introduced changes to the certificate revocation check to give you more fine-grained control over what is accepted as a valid 
certificate.  This update sees further controls added in the Power BI Desktop Options.  You can find these options in Options -> Global -> Security:

With this release of Power BI Desktop, external tools integration has been 
made Generally Available.  You can leverage a wide range of additional 
semantic modelling features, DAX query / expression optimisation 
and authoring utilities and application lifecycle management (ALM) 
capabilities in Power BI Desktop by using ALM Toolkit, Tabular Editor, 
DAX Studio, Metadata Translator, and many more open-source tools.  

Along with GA, following additional enhancements have also been 
provided:
	 •		  support for dynamic format strings
	 •		  metadata translation
	 •		  object-level security (OLS).

Many users have noticed frequent updates to Power BI Desktop being 
published outside of the regular monthly cycle.  These updates mostly 
provide fixes to issues found with that month’s release, which will be 
carried forward into the next month’s release.  However, Microsoft 
concedes they have not been very clear as to what fixes are included 
in each ad hoc update.  Therefore, they have announced the Power 
BI Desktop change log so now you can see exactly what fixes are part 

of what update.  You can find it at https://docs.microsoft.com/en-us/
power-bi/fundamentals/desktop-change-log.

If you download the installer from Microsoft.com you’ll have to download 
each update manually.  If you get Power BI Desktop through the Store – 
which is where Microsoft wishes to push you – you’ll be delivered these 
updates automatically.

More next month, we’re sure!

The A to Z of Excel Functions: FLOOR

After a night on the tiles, we found this image…
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Have you found the FLOOR in this function?  This function returns number rounded down, towards zero, to the nearest multiple of significance:

For example, if you are an American (which, let’s be honest is all Microsoft really cares about) and you want to want to avoid using cents in your 
prices (that makes no cents) and your product is priced at $4.44, use the formula =FLOOR(4.44, 0.05) to round prices down to the nearest nickel.

The FLOOR function employs the following syntax to operate:

FLOOR(number, significance)

The FLOOR function has the following arguments:

	 •		  number: this is required and represents the value you wish to round
	 •		  significance: this is also required. This is the multiple used for rounding.

It should be further noted that: 

	 •		  if either argument is nonnumeric, FLOOR returns the #VALUE! error value
	 •		  regardless of the sign of number, a value is rounded down when adjusted towards zero.  If number is an exact multiple of significance, no 	
			   rounding occurs
	 •		  it is noted if number is positive, significance should be too
	 •		  if number is negative, positive significance will round number away from zero (that’s right, a flaw in FLOOR!).

Please see our example below:

The A to Z of Excel Functions: FLOOR.MATH

Not to be confused with a floor mat...  This function actually rounds a number down to the nearest integer or to the nearest multiple of significance 
(see below).

The FLOOR.MATH function employs the following syntax to operate:

FLOOR.MATH(number, [significance], [mode])

The FLOOR.MATH function is slightly more sophisticated than FLOOR and has the following arguments:

	 •		  number: this is required.  This number is what is to be rounded (down for positive numbers)
	 •		  significance: this is optional.  This represents the multiple to which number is to be rounded
	 •		  mode: also optional.  For negative numbers, this controls whether number is rounded toward or away from zero.

It should be further noted that: 

	 •		  by default, positive numbers with decimal portions are rounded down to the nearest integer, e.g. 6.3 is rounded down to 6, using the 	
			   default significance (1)
	 •		  by default, negative numbers with decimal portions are rounded away from 0 to the nearest integer, e.g. -6.7 is rounded to -7
	 •		  by using 0 or a negative number as the mode argument, you can change the direction of the rounding for negative numbers.  For example, 	
			   rounding the number -6.3 with a significance of 1 and a mode of -1 rounds toward zero (0), to -6
	 •		  the significance argument rounds the number down to the nearest integer that is a multiple of the significance specified.  The exception 	
			   is where the number to be rounded is an integer.  For example, for a significance of 3, the number is rounded down to the last integer that 	
			   is a multiple of 3
	 •		  if number divided by a significance of 2 or greater results in a remainder, the result is rounded down.
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Please see our next example below: 

The A to Z of Excel Functions: FLOOR.PRECISE

Beat the Boredom Suggested Solution

Last of the three!  This function returns a number that is rounded down to the nearest integer or to the nearest multiple of significance.  Regardless 
of the sign of the number, the number is rounded down.  However, if the number or the significance is zero, zero is returned.

As a recap, earlier in this month’s newsletter, we presented you with the following data:

The FLOOR.PRECISE function employs the following syntax to operate:

FLOOR.PRECISE(number, [significance])

The FLOOR.PRECISE function has the following arguments:

	 •		  number: this is required and represents the value to be rounded
	 •		  significance: this is optional.  This is the multiple to which number is to be rounded
	 •		  if significance is omitted, its default value is 1.

It should be further noted that: 

	 •		  the absolute value of the multiple is used, so that the FLOOR.PRECISE function returns the mathematical FLOOR irrespective of the signs of 	
			   number and significance
	 •		  like CEILING.PRECISE, Excel’s intellisense (i.e. the AutoComplete) does not appear to recognise this function – but it still works.

Please see our final example below: 

More Excel Functions next month.
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However, we want to present it as follows automatically:

This sounds like a job for Power Query, which is our recommended approach.  Therefore, the first thing we’ll do is load the Table into the Power 
Query Editor, viz.

It was hinted earlier that this transformation fell in between an unpivot and a pivot.  Well, I sort of lied – it’s actually one of each.  First, we need to 
unpivot.  Therefore, once in the Power Query Editor, we select the Name column only and then choose ‘Unpivot other columns’ from the ‘Unpivot 
columns’ dropdown in the Transform tab, as pictured:

Note you don’t select the Budget and Forecast columns and unpivot them.  If you do that, if the number of years were to be added, these columns 
wouldn’t be unpivoted.  It’s safer to unpivot everything except for the Name field, viz.
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If more fields appear (e.g. 2021 Budget, 2021 Forecast, 2021 Variance), these would automatically unpivot too.  

Next, we want to split the Attribute column up into year and whether it is Budget or Forecast (in this instance).  To do this, we should split the column 
at the space in each text string.  This space is known as a delimiter, so it makes sense to select the Attribute column and then choose to split the 
column by delimiter as follows:

Bizarrely, this transformation is on the Home tab, not the Transform tab!  Select the ‘By Delimiter’ option from the ‘Split column’ dropdown.  This will 
generate the ‘Split Column by Delimiter’ dialog, where we will split on the first, left-most occurrence of the space delimiter. 

This results in the Attribute column effectively being split in two:
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We are nearly there.  We’ve decomposed (so to speak!), now we need to “re-compose”.  It’s time to select the Attribute.2 column and use it for a 
pivot:

Having selected the Attribute.2 column, select ‘Pivot column’ from the Transform tab.  This gives rise to the ‘Pivot Column’ dialog:

Ensure that it is the Attribute.2 column that is used to create new 
columns.  Then, select the Value field as the ‘Values Column’ and choose 
‘Sum’ as the ‘Aggregate Value Function’ in the ‘Advanced options’, all as 

pictured (above).  This will then pivot the Attribute.2 column, creating 
two columns, Budget and Forecast, summing the values which relate to 
each context:
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All that’s left to do now is rename the Attribute.1 column to Year and load it back into Excel:

Until next time.

 

Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 7 - 9 Apr 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 14 Apr 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 15 - 16 Apr 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 10 - 12 May 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 17 May 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 18 - 19 May 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 15 - 17 Jun 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 22 Jun 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 23 - 24 Jun 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 19 - 21 Jul 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 26 Jul 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 27 - 28 Jul 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 23 - 25 Aug 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 30 Aug 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 31 Aug - 1 Sep 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 29 Sep - 1 Oct 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 6 Oct 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Hey, it’s not our fault so many do the same thing this month!

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This year, we thought we’d revisit 
each function key in depth (there are 12 – one for each month of the year!).  Given it’s now April, let’s look at the F4 tips:

Keystroke What it does

F4 In Excel: redo
In Edit mode / Formula bar: toggle $ references

ALT + F4 Close application

CTRL + F4 Close window

SHIFT + F4 Find Next (from most recent search)

ALT + SHIFT + F4 Close application

CTRL + ALT + F4 Close application

CTRL + SHIFT + F4 Find Previous (from most recent search)

CTRL + ALT + SHIFT + F4 Close application
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Location Course Date Date Duration Duration

Online (Australia) Financial Modelling 7 - 8 Oct 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 3 - 5 Nov 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 10 Nov 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 11 - 12 Nov 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 8 - 10 Dec 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 15 Dec 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 16 - 17 Dec 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days


